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Systems, Applications, Products in Data Processing
Neurottstrasse 16
69190 Walldorf, Germany
(hereinafter: SAP)

and

you
(hereinafter: Customer)

1. Subject Matter of the Agreement
a) SAP grants Customer a non-exclusive, non-transferrable, royalty-free license to use the STLport.org C++ library (STLport)

and its documentation without fee.
b) By downloading, using, or copying STLport or any portion thereof Customer agrees to abide by the intellectual property laws,

and to all of the terms and conditions of this Agreement.
c) The Customer may distribute binaries compiled with STLport (whether original or modied) without any royalties or

restrictions.
d) Customer shall maintain the following copyright and permissions notices on STLport sources and its documentation

unchanged: Copyright 2001 SAP AG
e) The Customer may distribute original or modied STLport sources, provided that:

■ The conditions indicated in the above permissions notice are met;
■ The following copyright notices are retained when present, and conditions provided in accompanying permission notices

are met:

Coypright 1994 Hewlett-Packard Company
Copyright 1996,97 Silicon Graphics Computer Systems Inc.
Copyright 1997 Moscow Center for SPARC Technology.
Copyright 1999,2000 Boris Fomitchev
Copyright 2001 SAP AG

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the
suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation. Silicon Graphics makes no representations about the suitability of this
software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation. Moscow Center for SPARC makes no representations about the
suitability of this software for any purpose. It is provided “as is” without express or implied warranty.
Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided "as
is", with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software
for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify
the code and to distribute modied code is granted, provided the above notices are retained, and a notice that the code
was modied is included with the above copyright notice.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for
any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy.
SAP offers this liability and warranty obligations only towards its customers and only referring to its modications.

2. Support and Maintenance
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SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.
All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be
subject to a separate contract.

3. Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is
error-free, without material defects or suitable for a specic application under third-party rights. Technical data, sales brochures,
advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

4. Limited Liability
a) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be

compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the
failure of a guaranteed attribute.

b) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the
total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its
occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that
point in time representing a typical transfer of the software.

c) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost prot.
d) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.
e) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at

the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the
other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.

f) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents
of SAP.

Documentation in the SAP Service Marketplace
You can nd this document at the following address: service.sap.com/instguides
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Typographic Conventions
Example Description

< > Angle brackets indicate that you replace these words or characters with appropriate
entries to make entries in the system, for example, “Enter your <User Name> ”.

® Arrows separating the parts of a navigation path, for example, menu options

Example Emphasized words or expressions

Example Words or characters that you enter in the system exactly as they appear in the
documentation

Example Textual cross-references to a URL, for example, www.sap.com

/example Shortcuts added to the URL of a homepage to enable quick access to specic
content on the Web

Example
■ Words or characters quoted from the screen. These include eld labels, screen

titles, pushbutton labels, menu names, and menu options.
■ Cross-references to other documentation or published works

Example
■ Output on the screen following a user action, for example, messages
■ Source code or syntax quoted directly from a program
■ File and directory names and their paths, names of variables and parameters,

and names of installation, upgrade, and database tools

EXAMPLE Technical names of system objects. These include report names, program names,
transaction codes, database table names, and key concepts of a programming
language when they are surrounded by body text, for example, SELECT and INCLUDE

EXAMPLE Keys on the keyboard
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Document History

Document History

. Caution
Before you start the implementation, make sure you have the latest version of this document.
You can nd the latest version in SAP Service Marketplace at the following internet address:
service.sap.com/instguides .

The following table provides an overview on the most important document changes.

Version Date Description

2.00 02/28/2005 Revised Version

vi PUBLIC February 28, 2005



Table of Contents

Table of Contents

Chapter 1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.1 Target Audience . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.2 About this Document . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.3 New Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.4 Before You Start . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

1.4.1 SAP Notes for the Installation . . . . . . . . . . . . . . . . . . . . . . 4
1.4.2 Information Available on SAP Service Marketplace . . . . . . . . . . . . . . 5
1.4.3 Accessing the SAP Library . . . . . . . . . . . . . . . . . . . . . . . 6
1.4.4 Naming Conventions . . . . . . . . . . . . . . . . . . . . . . . . . 7

Chapter 2 Standard Installation . . . . . . . . . . . . . . . . . . . . . . . . 9
2.1 Installation Process . . . . . . . . . . . . . . . . . . . . . . . . . . 9

2.1.1 Preparing the Installation DVDs . . . . . . . . . . . . . . . . . . . . . 10
2.1.2 Installing the MS SQL Server Database Software . . . . . . . . . . . . . . . 11
2.1.3 Installing the Corrected MS SQL Server Collation . . . . . . . . . . . . . . 15
2.1.4 Preparing your System for an Java Add-In Installation . . . . . . . . . . . . . 17
2.1.5 Installing an SAP System Instance Using SAPinst . . . . . . . . . . . . . . . 17

2.1.5.1 Running SAPinst on Windows . . . . . . . . . . . . . . . . . . . . . . 18
2.1.5.2 Using SAPinst GUI . . . . . . . . . . . . . . . . . . . . . . . . . . 22
2.1.5.3 Interrupted Installation with SAPinst . . . . . . . . . . . . . . . . . . . 23
2.1.5.4 Remote Installation with SAPInst (Optional) . . . . . . . . . . . . . . . . 25

2.1.5.4.1 General Information about the Remote Installation with SAPinst (Optional) . . . . . 25
2.1.5.4.2 Starting SAPinst on the Remote Host (Optional) . . . . . . . . . . . . . . . 26
2.1.5.4.3 Starting SAPinst GUI on the Local Host (Optional) . . . . . . . . . . . . . . 27

2.2 Post-Installation Activities . . . . . . . . . . . . . . . . . . . . . . . 28
2.2.1 Starting and Stopping the SAP System . . . . . . . . . . . . . . . . . . . 30
2.2.2 Logging On to the J2EE Engine . . . . . . . . . . . . . . . . . . . . . . 31
2.2.3 Installing the SAP License . . . . . . . . . . . . . . . . . . . . . . . 32
2.2.4 Installing the SAP Online Documentation . . . . . . . . . . . . . . . . . 32
2.2.5 Checking the SAP Java Documentation . . . . . . . . . . . . . . . . . . 33
2.2.6 Applying the Latest Kernel and Support Packages . . . . . . . . . . . . . . . 34
2.2.7 Performing a Full Installation Backup . . . . . . . . . . . . . . . . . . . 35
2.2.8 Changing Passwords of Created Java Users . . . . . . . . . . . . . . . . . 36
2.2.9 Applying Strong Encryption After the Installation . . . . . . . . . . . . . . 37
2.3 Additional Information . . . . . . . . . . . . . . . . . . . . . . . . 37

2.3.1 Additional Information about the J2EE Engine . . . . . . . . . . . . . . . . 37
2.3.2 Conguring User Management to Use an LDAP Directory (Optional) . . . . . . . 40
2.3.3 General Information on How to Delete an SAP System . . . . . . . . . . . . . 40
2.3.4 Deleting an SAP Instance . . . . . . . . . . . . . . . . . . . . . . . . 41

February 28, 2005 PUBLIC vii



Table of Contents

2.3.5 Deleting a Java Add-In Installation . . . . . . . . . . . . . . . . . . . . 42
2.3.6 Deleting the MS SQL Server Database Instance and the Database Software . . . . . . 44

Chapter A Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
A.1 The Main SAP Documentation Types . . . . . . . . . . . . . . . . . . . 45

viii PUBLIC February 28, 2005



1 Introduction

1 Introduction

1.1 Target Audience

■ System administrators
■ Technology consultants

1.2 About this Document

This documentation explains how to install the SAP Web Application Server (SAP Web AS) 6.40 Support
Release 1 Java on Windows when your database is MS SQL Server.
SAP Web AS is the application server of SAP NetWeaver. For more information on the technology provided by
SAP NetWeaver, see SAP Service Marketplace at: service.sap.com/netweaver
This documentation focuses on the Java part of the installation. It covers the installation and
post-installation, which is the second part of the installation.
For the planning and preparation, which is the rst part of the installation, see Component Installation Guide ‒
SAP Web Application Server 6.40 SR1 Java on Windows: MS SQL Server, Part I ‒ Planning and Preparation.

. Note
If you want to install theABAP part of SAPWeb AS, see the documentation Component Installation Guide ‒ SAP
Web Application Server 6.40 SR1 ABAP on Windows: MS SQL Server, Part I and Part II on SAP Service Marketplace
at: service.sap.com/instguidesnw04.

You are now here:
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1 Introduction

1.2 About this Document

Figure 1:

Constraints

. Caution
You must only use the SAP installation tools according to the instructions and for the purposes described
in the SAP installation documentation. Improper use of the SAP installation tools can damage les
and systems already installed.

You need to consider the following constraints before you start your installation:

■ This documentation only applies if you are installing an MS SQL Server database with a Windows operating
system.

■ SAP system installations should only be performed by SAP Technical Consultants, who are certied for
your operating system, your database, and the SAP system that you are installing.

■ For downward-compatible releases of DB/OS platforms for SAP products, SAP plans to regularly release
the newest database (DB) and operating-system (OS) versions of SAP products. These releases are
downward-compatible with earlier SAP system releases.

2 PUBLIC February 28, 2005



1 Introduction

1.3 New Features

Be aware that, for already shipped SAP components, we only support the installation for database versions
proposed by the installation tool. Therefore, you must install a SAP component or perform a system copy
using a downward-compatible database as follows:
■ Install the component with the old proposed database version.
■ Upgrade the old database version to the downward-compatible new version.

1.3 New Features
SAP System Installation

Area Description

SAPinst As of SAPWeb AS 6.40 SR1 there is a new F1-eld-help displaying information about the
input parameter elds of the SAPinst screens. This new eld help replaces the former
“What’s this”-help on the SAPinst screens and the former input parameter tables in
the installation guides.

Integration of the
installation of SAP
Internet Graphic
Server (IGS)

As of SAP Web AS 6.40 the installation of the SAP Internet Graphic Server (IGS) is
integrated into the installation of SAP Web Application Server 6.40.

Installation of a Java
server in default
mode

For this installation type, default values are used for most installation parameters. If
those default values are sufcient for your purposes, you can install a SAP Web AS Java
central system quickly and easily.

User Management
Engine (UME)

You are now able to congure the User Management Engine (UME) of an SAP Web AS
Java system to use the user management of a separate ABAP system.

System Landscape
Directory (SLD)

The SLD is the central information provider for the whole system landscape. Generally,
the SLD is deployed after the installation of SAP Web AS Java 6.40.

Installation DVDs The installation is started from the SAP Installation Master DVD.

SAPinst
Troubleshooting
Guide for SAP Web
AS Java Installation

This documentation provides troubleshooting information for the Java system
installation procedures with the tool SAP Landscape ImplementationManager, referred
to as SAPinst in this document.
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1 Introduction

1.4 Before You Start

Operating System

Area Description

Support of Operating
Systems

■ See the Product Availability Matrix (PAM) on SAP Service Marketplace at
service.sap.com/platforms→ Product Availability Matrix

■ For information on Windows operating system security, see
www.microsoft.com/security

1.4 Before You Start

The following sections provide information on:

■ SAP Notes for the Installation [page 4]
■ Information in the SAP Service Marketplace [page 5]
■ Accessing the SAP Library [page 6]
■ Naming Conventions [page 7]

1.4.1 SAP Notes for the Installation

Youmust read the following SAP Notes before you start the installation. These SAP Notes contain the most
recent information on the installation, as well as corrections to the installation documentation.
Make sure that you have the up-to-date version of each SAP Note which you can nd in the SAP Service
Marketplace at service.sap.com/notes.

SAP Notes for the Installation

SAP Note Number Title Description

786608 SAPWebAS 6.40 SR1 Java onWindows Operating-system specic
information about the Java system
installation and corrections to this
documentation

786671 SAP Web AS 6.40 SR1 on Windows:
MS SQL Server

MS SQL Server-specic information
about the SAP system installation and
corrections to this documentation

79991 Multi Language Support / Unicode Information about Unicode SAP
systems and their availability. It is
only required if you plan to install a
Unicode SAP system.
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1 Introduction

1.4 Before You Start

SAP Note Number Title Description

45619 R/3 with several languages or
typefaces

Information about multiple
languages and/or multiple typefaces
on one SAP system.

42305 RSCPINST (NLS installation tool) Information about language and
code page settings in your SAP
system.

1.4.2 Information Available on SAP Service
Marketplace

Information on the following areas is available on SAP Service Marketplace.

Description Internet Address Title

SAP Notes service.sap.com/notes -

Released platforms and
operating systems

service.sap.com/platforms -

Master Guide for SAP
NetWeaver '04

service.sap.com/instguidesNW04 →
Installation

Master Guide — SAP NetWeaver '04

List of media for
installation or upgrade for
SAP NetWeaver '04 SR1

service.sap.com/instguidesNW04 →
Installation

Media Information for SAP NetWeaver '04
SR1

Installation of an SAP
system based on SAP Web
AS ABAP

service.sap.com/instguidesNW04 →
Installation → SAP Web AS

Installation Guide ‒ SAP Web Application
Server 6.40 SR1 ABAP on <OS>:
<Database>

Patching of SAP
NetWeaver ’04 scenarios

service.sap.com/instguidesNW04 →
Operations

Support Package Stack Guide ‒ SAP
Netweaver’04 Support Package Stack
<current stack>

Upgrade to SAP Web AS service.sap.com/instguidesNW04 →
Operations

Upgrade to SAP Web Application Server
<Platform>: <Database>

Installation of SAP
NetWeaver Developer
Workplace

service.sap.com/instguidesNW04 →
Installation → Dev Env

Installation Guide ‒ SAP NetWeaver
Developer Workplace

Installation of SAP
NetWeaver Developer
Studio

service.sap.com/instguidesNW04 →
Installation → Dev Env

Installation Guide ‒ SAP NetWeaver
Developer Studio
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1 Introduction

1.4 Before You Start

Description Internet Address Title

Installation of the
SAP System Landscape
Directory (SLD)

service.sap.com/instguidesNW04 →
Installation → SAP Web AS

Post-Installation Guide ‒ SAP System
Landscape Directory on SAP Web AS Java
6.40

Unicode SAP systems and
their availability

service.sap.com/unicode

See also SAP Note 79991.
-

Technical infrastructure
‒ conguration scenarios
and related aspects such as
security, load balancing,
availability, and caching

service.sap.com/ti -

Network infrastructure service.sap.com/network -

System sizing service.sap.com/sizing Quick Sizer tool

Front End installation service.sap.com/instguidesNW04 →
Installation → SAP Web AS

Front End Installation Guide (this guide is
available on the SAP Presentation DVD)

High availability service.sap.com/ha -

Homogeneous and
heterogeneous system
copy for a Java system

service.sap.com/instguidesNW04 →
Installation → SAP Web AS

Homogeneous and Heterogeneous System
Copy for SAP Systems based on SAP Web
Application Server Java 6.40 SR1

Security service.sap.com/security

. Note
For information on Windows
operating system security, see
www.microsoft.com/security

-

Information on SAP
Support Package Stacks

service.sap.com/sp-stacks -

1.4.3 Accessing the SAP Library

For more information about SAP NetWeaver, access the SAP Library from the SAP Help Portal at
help.sap.com/nw04:

1. Choose the required language.
2. Choose SAP NetWeaver.

6 PUBLIC February 28, 2005

http://service.sap.com/%7Eform/handler?_APP=01100107900000000342&_EVENT=DISP_PRINT&_NNUM=79991&_NLANG=en&_NVERS=0


1 Introduction

1.4 Before You Start

1.4.4 Naming Conventions

In this documentation, the following naming conventions apply:

Terminology

SAP system refers to SAP Web AS.
ABAP system refers to SAP Web AS ABAP.
Java system refers to SAP Web AS Java.
ABAP+Java system refers to SAP Web AS ABAP+Java.

Variables

Variables Description

<SAPSID> SAP system ID in uppercase letters

<sapsid> SAP system ID in lowercase letters

<DBSID> Database ID in uppercase letters

<dbsid> Database ID in lowercase letters

<host_name> Name of the corresponding host

<INSTDIR> Installation directory for the SAP system

<DVD_DIR> Directory on which a DVD is mounted

<OS> Operating system name within a path

<SCHEMA_ID> Database schema ID

The following example shows how the variables are used:

. Example
Log on as user <sapsid>adm and change to the directory \usr\sap\<SAPSID>.
If your SAP system ID is C11, log on as user c11adm and change to the directory
\usr\sap\C11.
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1.4 Before You Start
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2 Standard Installation

2 Standard Installation

2.1 Installation Process

This section provides information about how to perform the installation of your SAP system.
You have completed the planning and preparation activities, described in the Part I of the Component Installation
Guide, before you start the installation.
You are now here:

Figure 2:

You perform the following steps

1. You prepare the installation DVDs [page 10].
2. You install the MS SQL Server database software [page 11].
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2 Standard Installation

2.1 Installation Process

3. If required, you install the corrected MS SQL Server collation [page 15].
4. If required, you prepare your system for a Java Add-In installation [page 17].
5. You install an SAP instance using SAPinst [page 18].

2.1.1 Preparing the Installation DVDs

You use this procedure to prepare the installation DVDs.

. Recommendation
We recommend that you make all required DVDs available in parallel.

Procedure

1. Identify the required DVDs for your installation as listed below and keep them separate from the remaining
DVDs. This helps you to avoid mixing up DVDs during the installation.

. Caution
The DVD names in the table below are abbreviated.
You can nd the full names inMedia Information for SAP NetWeaver'04 SR1 on SAP Service Marketplace at:
service.sap.com/instguidesNW04 → Installation

. Note
For the installation of a Unicode SAP system, theUnicode SAP Kernel DVD is required. For the installation
of a non-Unicode SAP system, the non-Unicode SAP Kernel DVD is required.

The following table shows the required DVDs for the installation of a Java System or a Java Add-In
for ABAP:

SAP Instance Installation Required DVD

Central Instance,
Central Services Instance,
Database Instance,
Dialog Instance

■ SAP Installation Master DVD
■ SAP Java DVD

2. Use one of the following methods to make DVDs available in parallel:
■ Before the installation:

Have sufcient DVD drives
Copy DVDs manually to local hard disks

■ During the installation:
Use the SAPinst DVD Browser dialog, that is, you can check the entered location and then copy the
entire DVD to the path you entered in column Copy Package to.
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2 Standard Installation

2.1 Installation Process

2.1.2 Installing the MS SQL Server Database Software

The MS SQL Server software has to be installed on each host in the system where you intend to set up an SAP
instance. To prepare a host for the installation of a central, dialog or database instance, you have to install
the database software. Depending on the type of host involved, you either have to install the software for
the database client or server.

Installation on 32-Bit Systems

■ The software for the servermust be installed on the host where the database runs. It provides all the
functions required to run a relational database management system. To install the server software you
run a batch le.

■ The software for the client must be installed on all hosts without the database. It enables the
communication between a host and the database. When you install the client software you use the
Microsoft SQL Server 2000 installation program.

Procedure

1. Log on to the host as a local administrator.

. Caution
For security reasons, install the MS SQL Server software on an NTFS partition.

2. Insert the MS SQL Server 2000 RDBMS DVD into your DVD drive.
3. For the database server, run the le SAP46C-.BAT located in the MSSQL8_I386 directory of the RDBMS

DVD.

. Recommendation
SAP recommends that you perform the installation using the le SAP46C-.BAT
If you nevertheless decide to use theMicrosoft SQL Server installation program with autorun.exe, enter
the information as specied in the Server Input column of the table below.

For a database client, start the installation program with autorun.exe located in the MSSQL8_I386
directory of the RDBMS DVD. Enter the required information as specied in the table below in the Client
Input column.

. Note
If youmount the DVD from a remote server, it must be assigned a drive letter. The installation writes a
log le sqlstp.log to the Windows directory %windir%

February 28, 2005 PUBLIC 11
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Input for MS SQL Server Installation on 32-Bit Systems

Window Server Input Client Input

Microsoft SQL Server
2000 Enterprise
Edition

Select SQL Server 2000
Components.

Select SQL Server 2000
Components.

Install Components
Microsoft SQL Server
2000 Enterprise
Edition

Select Install Database Server. Select Install Database Server.

Welcome Choose Next. Choose Next.

Computer Name Select Local Computer. Select Local Computer.

Installation Selection Select Create a new instance
of SQL Server, or install Client
Tools.

Select Create a new instance
of SQL Server or install Client
Tools.

User Information Enter your personal
information.

Enter your personal
information.

Software License
Agreement

Choose Yes. Choose Yes.

CD-Key Enter the key specied in
the le SAPCDKEY.txt in
the MSSQL8_I386 directory
of the RDBMS DVD.

Enter the key specied in
the le SAPCDKEY.txt
in the MSSQL8_I386

directory of the RDBMS
DVD.

Installation Denition Select Server and Client Tools. Select Client Tools Only.

Instance Name Select Default.
Do not specify an instance
name.

Dialog box does not
appear.

Setup Type Select Custom. Dialog box does not
appear.

Select Components Select all components. Select all components.

Service Accounts Select Use the same account
for each service. Auto start SQL
Server Service.
Select Use the Local
System account.

Dialog box does not
appear.
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Window Server Input Client Input

Authentication mode Select the authentication
mode.
We recommend to use
Windows authentication mode.

. Note
For a Java system,
Mixed mode is
required. SAPinst
automatically
changes the
authentication mode
intoMixed mode when
installing a Java
system.

Dialog box does not
appear.

Collation settings Select SQL Collations.
From the drop-down list
select Binary order, for use
with the 850 (Multilingual)
Character Set.

Dialog box does not
appear.

Network Libraries Leave selection unchanged
and choose Next.

Dialog box does not
appear.

Start Copying Files Choose Next. Choose Next.

Choose Licensing
Mode

Select the mode you
require.

Dialog box does not
appear.

4. When you have nished the installation, install Service Pack 3 for SQL Server 2000, and the latest hot x.
For more information on how to get Service Pack 3, see SAP Note 62988. For the installation of SP3, also
see the SP3README.HTM le on the RDBMS DVD.
For more information on the latest hot x, see SAP Note 608651.

5. If you have installed the server software, install the corrected MS SQL Server Collation.

Installation on 64-Bit Systems

In a 64-bit system, you cannot run the SQL Server 2000 graphical user interface (GUI) tools, with the following
exceptions:

■ Client Network Utility (supported by the 64-bit Windows operating system)
■ Server Network Utility
■ Service Manager
■ SQL Server 2000 Licensing (in Control Panel)
■ Setup.exe (supported by Windows Installer)
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If you want to use the other SQL Server 2000 GUI tools with the 64-bit version of SQL Server 2000, you have
to install them with the 32-bit version of SQL Server 2000 on a 32-bit computer and use them to remotely
manage the 64-bit server.

. Note

■ You can install the 32-bit graphical user interface management tools from the 32-bit SQL Server
2000 RDBMS DVD.

■ Graphical interface management tools which were installed with the 32-bit version of SQL Server
2000 are not supported in the 64-bit version. For more information refer to the readme.txt le in
the MSSQL8_IA64\IA64 subdirectory.

Procedure

1. Log on to the host as a local administrator.

. Caution
For security reasons, install the MS SQL Server software on an NTFS partition.

2. Insert the MS SQL Server 2000 RDBMS DVD into your DVD drive.
3. To start the installation, run setup.exe located in the directory MSSQL8_IA64\IA64.
4. Enter the required information as specied in the following table.

. Note
For the installation of the client software, some of the screens may not appear.

Input for the MS SQL Server Installation on 64-Bit Systems

Window Input

Registration Information Enter your name and the product key specied in the le
SAPCDKEY.txt in the root directory of the RDBMS DVD.

Software License Agreement Choose Yes.

Feature Selection ■ Server Software:
Select all components.

■ Client Software:
Select SQL Server Management Tools.

. Note
To select a component, left-click on it and choose
Entire feature will be installed on local hard drive.
To deselect a component, left-click on it, and choose
Entire feature will be unavailable.

Instance Name Select the instance type you want to install.
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Window Input

Service Account Select Use the same account for each service. Auto start SQL Server Service.
Select Use the Local System account.

Authentication Mode ■ Select the authentication mode.
We recommend to useWindows authentication mode.

. Note
For a Java system, Mixed mode is required. SAPinst
automatically changes the authentication mode into
Mixed mode when installing a Java system.

■ Enter and conrm the sa login.

. Note
If you have chosenWindows authentication mode, the sa
login is created, but cannot be used.

Security Enhancement:
Cross Database Ownership Chaining

Leave selection unchanged and choose Next.

Collation Settings Select SQL Collations.
From the drop-down list select Binary order, for use with the 850
(Multilingual) Character Set.

Licensing Mode Select the licensing mode and choose Next.

Ready to Install Select Install.

5. Install the latest hot x for SQL Server 2000. For more information, see SAP Note 608651
6. When you have installed the server software, install the corrected MS SQL Server Collation.

2.1.3 Installing the Corrected MS SQL Server
Collation

When you install the MS SQL Server 2000 database for an SAP system, in the eld Collation Settingswe recommend
that you select Binary order for use with the 850 (Multilingual) Character Set.
This means that all new databases and table columns will be created with this collation setting.

. Note
To view the default collation of MS SQL Server use the query:
select serverproperty('collation')

This query returns the default collation of the overall server. When you have selected code page cp850, it
returns: SQL_Latin1_General_CP850_BIN
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Unfortunately this collation setting does not sort Unicode data as it is required by an SAP system. To solve this
problem, Microsoft provides a corrected collation as a hot x (QFE) for SQL Server. The QFE is included in the
hot x you installed during the standard installation for the MS SQL Server database. [page 11]
When you have installed the hot x, you have to run the executable INSTCOLL.EXE from SAP, as desribed
below. For more information on INSTCOLL.EXE, see SAP Note 600027.

Prerequisites

■ You have installed the MS SQL Server 2000 database. In the eld Collation Settings, you selected Binary order for
use with the 850 (Multilingual) Character Set.

■ If you run your SQL Server in a 32-bit system, you have installed SP3 and the latest hot x. For more
information, refer to SAP Note 62988 and SAP Note 608651.

■ If you run your SQL Server in a 64-bit system, you have installed the latest hot x. For more information,
see SAP Note 608651.

. Note
Besides applying SP3 and/or the hot x you do not have to make any changes on the client side (SAP
application servers).

■ To obtain a correct collation order with MS SQL Server, you have to use the new collation for all new
installations of a Unicode or non-Unicode SAP system with the MS SQL Server database. New versions of
the SAPinst installation tool check for the new collation.

■ At present, there is no need to convert existing SAP system installations to the new collation.
■ A new SAP system using the new collation and an existing SAP system that is using the old collation cannot

run as two databases in the same MS SQL Server instance. If you want to install a new system on a database
server with an existing system you have to apply the new collation with INSTCOLL.EXE.

Procedure

1. Download the INSTCOLL.EXE le, which is attached as zip le to SAP Note 600027, and extract it to your
server.

2. Open a command prompt and change to the directory where you extracted the INSTCOLL.EXE le.
3. Enter the following:

■ For a default instance enter: INSTCOLL.EXE
■ For a named instance enter: INSTCOLL.EXE -S<server>\<instance> (without any spaces after —S)
The collation executable starts the SQL Server Service if it is not running already and runs several checks.
When you are asked to apply the new collation to all databases conrm with Yes.
When the conversion has nished it stops the SQL Server Service.

4. To verify whether the MS SQL Server is properly congured, run:
select serverproperty('collation')

. Caution
You have to run INSTCOLL.EXE only once to apply the new collation. To convert a single SAP database
to the new collation, see SAP Note 600027.

16 PUBLIC February 28, 2005

http://service.sap.com/%7Eform/handler?_APP=01100107900000000342&_EVENT=DISP_PRINT&_NNUM=600027&_NLANG=en&_NVERS=0
http://service.sap.com/%7Eform/handler?_APP=01100107900000000342&_EVENT=DISP_PRINT&_NNUM=62988%20&_NLANG=en&_NVERS=0
http://service.sap.com/%7Eform/handler?_APP=01100107900000000342&_EVENT=DISP_PRINT&_NNUM=608651&_NLANG=en&_NVERS=0
http://service.sap.com/%7Eform/handler?_APP=01100107900000000342&_EVENT=DISP_PRINT&_NNUM=608651&_NLANG=en&_NVERS=0
http://service.sap.com/%7Eform/handler?_APP=01100107900000000342&_EVENT=DISP_PRINT&_NNUM=600027&_NLANG=en&_NVERS=0
http://service.sap.com/%7Eform/handler?_APP=01100107900000000342&_EVENT=DISP_PRINT&_NNUM=600027&_NLANG=en&_NVERS=0


2 Standard Installation

2.1 Installation Process

Result

You can now continue with the standard SAP system installation and install any SAP instance on this server.

2.1.4 Preparing your System for an Java Add-In
Installation

If you want to perform a Java Add-In installation for an existing ABAP system that has been upgraded to Web
AS 6.40 SR1, you have to perform the following steps:

Procedure

1. In your default prole \usr\sap\<SAPSID>\SYS\profile\default.pfl check the parameter
dbs/mss/schema.
■ If it is set to <sapsid> (lowercase letters), no further action is required.
■ If it does not exist or is set to dbo, convert the schema as follows:

a) If you use a MS Cluster environment, bring your SAP resource ofine.
b) Start the SAPinst schema conversion tool:

■ For a standard installation, start SAPinst [page 18] and choose SAPNetWeaver '04 Support Release 1 →
Database Tools → MS SQL Server → Schema conversion

■ For an installation with Microsoft Cluster (MSCS) open a command prompt and change to the
directory: IM<x>\SAPINST\NT\<platform>.
Start SAPinst manually with the command:
sapinst SAPINST_USE_HOSTNAME=<virtual_hostname_of_SAP_system>

c) Enter the required information in the installation screens. For more information about the input
parameters use the F1 help.

d) MSCS only: When the conversion is nished, bring the SAP resource SAP-R/3 <SAPSID> ofine
again.

2. Check if you use SQL Server collation SQL_Latin1_General_CP850_BIN2:
a) Start the SQL Server Enterprise Manager.
b) Right-click on your SQL Server and choose Properties.

In the General tab under Server collation you see the collation installed.
■ If you use SQL_Latin1_General_CP850_BIN2 no further action is required.
■ If you use collation SQL_Latin1_General_CP850_BIN, convert it to SQL_Latin1_Gen-

eral_CP850_BIN2 as described in Installing the Corrected MS SQL Server Collation [page 15].

2.1.5 Installing an SAP System Instance Using
SAPinst
The following sections tell you how to run SAPinst to install an SAP instance and provide useful background
information about SAPinst itself.
They describe an installation where SAPinst GUI and SAPinst server are running on the same host as well as a
remote installation, where SAPinst GUI is running on another host:
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■ Running SAPinst on Windows [page 18]
■ Using SAPinst GUI [page 22]
■ Interrupted Installation with SAPinst [page 23]
■ Remote Installation with SAPinst [page 25]

2.1.5.1 Running SAPinst on Windows

This procedure tells you how to run SAPinst to install one or more SAP instances.
It describes an installation where SAPinst GUI and SAPinst server are running on the same host. If you want
to perform a remote installation (that is, SAPinst GUI is running on another host), see Remote Installation with
SAPinst [page 25].
Note the following about SAPinst:

■ SAPinst normally creates the installation directory sapinst_instdir where it keeps its log les, and which
is located. directly below the Program Files directory. If SAPinst is not able to create sapinst_instdir
directly below the Program Files directory, SAPinst tries to create sapinst_instdir in the directory
dened by the environment variable TEMP.

■ The SAPinst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or
SystemRoot). These executables are deleted after SAPinst has stopped running.
Directories with the name sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory.
You can safely delete them.
In the temporary directory you can also nd the SAPinst Self-Extractor log le dev_selfex.out, which
might be useful if an error occurs.

. Caution
If SAPinst cannot nd a temporary directory, the installation terminates with the error FCO-00058.

■ If you want to terminate SAPinst and the SAPinst Self-Extractor, do one of the following:
■ Right-click the icon for the SAPinst output window located in the Windows tray and choose Exit.
■ Click the icon for the SAPinst output window located in the Windows tray and choose File → Exit.

Prerequisites

■ Each SAP instance requires a separate installation directory.

. Recommendation
We recommend that you keep all installation directories until the system is completely and correctly
installed.

■ You need at least 130 MB of free space in the installation directory for each Java installation service. In
addition, you need 60-200 MB free space for the SAPinst executables.

■ If you are installing a second or subsequent SAP system into an existing database, make sure that the
database is up and running before starting the installation. For more information, see “Installation of
Multiple Components in One Database” in Part I — Planning and Preparation.
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Procedure

1. Log on to your host as a user who is a member of the local administrators group.
2. Insert the SAP Installation Master DVD in your DVD drive or mount it locally.

. Note
If you want to install a gateway instance you have to use the SAP Presentation DVD. In this case, replace
<SAP Installation Master DVD> with <SAP Presentation DVD> in this section.

3. Start SAPinst from the SAP Installation Master DVD by double-clicking sapinst.exe from the following
path:
<DVD drive>:\IM<x>\SAPINST\NT\<platform>

SAPinst GUI starts automatically by displaying theWelcome screen.
However, if there is only one component to install, SAPinst directly displays the rst input dialog without
presenting theWelcome screen.

. Note
SAPinst uses the ports 21212 during the installation for communication with SAPinst GUI. You get an
error message if one of these ports is already used by another service. In this case, open a command
prompt and change to <DVD drive>: \IM<x>\SAPINST\NT\<platform>.
Run sapinst.exe SAPINST_DIALOG_PORT=<free_port_number>

4. In theWelcome screen, select the corresponding installation service from the tree structure and choose Next.
■ For a Java system, you have the following installation services:
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Installation Services for a Java System

Installa-
tion Pro-
cedure

Installation Service Remarks

In-
stalling
a central
or dis-
tributed
Java sys-
tem

a) Choose one of the following:
■ Java System → <Database> → Default

Installation — Java System
■ Java System → <Database> → Custom

Installation — Java System
b) Java System → <Database> → Dialog Instance

Installation

a) Installs one of the
following:
■ A central or

distributed Java
system with
default installation
parameters.
This option allows
you to install the
Java system with
the default values
for the basic system
parameters.

■ A central or
distributed Java
system with
custom installation
parameters
This option allows
you to install the
Java system with
custom values
for the system
parameters.

b) Installs a dialog
instance.

■ For a Java Add-In system, you have the following installation services:

. Caution
If your existing SAP system includes a J2EE Engine 6.20, the installation services for a Java Add-In
delete the J2EE Engine 6.20 before installing the J2EE Engine 6.40 SR1.
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Installation Services for a Java Add-In Installation

Installa-
tion Pro-
cedure

Installation Service Remarks

In-
stalling
a Java
Add-In
for an
ABAP
system

a) Java Add-In for ABAP → <Database> → Java
System Finalization

b) Java Add-In for ABAP → <Database> → Dialog
Instance Finalization

a) Installs the SCS
instance, the Java part
of the central instance,
and the Java database
schema.

b) Installs the Java part of
the dialog instance.

. Caution
Do not patch the J2EE Engine or SDM during the deployment. Only apply patches after the whole
installation procedure of the J2EE Engine has been nished successfully.

SAPinst creates a subdirectory for each installation service, named
<sapinst_instdir>\<installation_service> which is located below %ProgramFiles%\sapinst_instdir.
The exact name of the subdirectory depends on the installation service chosen by you.

5. If SAPinst prompts you to log off from your system, log off and log on again. SAPinst restarts automatically.
6. Follow the instructions in the SAPinst dialogs and enter the required parameters.

. Note
For more information about the input parameters, position the cursor in the eld of the respective
parameter and press the F1 key.

After you have entered all required input information, SAPinst starts the installation and displays the
progress of the installation. If the installation was successful, the screen Finished installation successfully is
displayed.

7. For security reasons, delete the le <drive>:\Documents and

settings\%userprofile%\.sdtgui\sdtgui.trc, which contains all passwords entered during
the installation.

Troubleshooting

■ If an error occurs during the dialog phase, SAPinst:
■ Stops the installation
■ Displays a dialog informing you about the error
You can now directly view the log le by choosing View Logs
You must abort the installation with Stop or Reset, and try to solve the problem.

■ If an error occurs during the processing phase, SAPinst:
■ Stops the installation
■ Displays a dialog informing you about the error
You can now:
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■ Directly view the log le by choosing View Logs
■ Try to solve the problem.
■ Continue the installation by choosing Retry.
■ Stop or Reset the installation

For more information, see Interrupted Installation with SAPinst [page 23].

2.1.5.2 Using SAPinst GUI

The following buttons are available on the SAPinst GUI dialogs (input screens, installation progress screen,
message boxes):

Button / Function Key Meaning

F1 Displays detailed information about each input
parameter.
The new eld help replaces the former “What’s
this”-help on the SAPinst screens and the former input
parameter tables in the installation guide.

Back Displays the previous dialog for editing.

Next Displays the next dialog for editing.

Cancel Cancels the installation with the following options:

■ Stop
Stops the installation without further changing the
installation les. You can continue the installation
later from this point.

■ Reset
Resets all installation input les. All les in the
installation directory are removed from the system.
No backup is available. You must restart the
installation from the beginning.
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Button / Function Key Meaning

Log off Cancels the connection to the SAPinst GUI only. The
SAPinst server keeps running.

. Example
Typical case: For some reason you need to log
off during the installation from the host where
you control the installation with SAPinst GUI.
The installation continues while you are logged
off. You can later reconnect to SAPinst GUI
from another host to the same installation. For
this you need the SAP Installation Master DVD. For
more information on running SAPinst GUI in
standalone mode for a remote installation, see
section “Starting SAPinst GUI on the Local Host”.

View Log Displays the content of the sapinst.log le during the
installation.

Retry Performs the installation step again (if an error has
occurred).

Stop Stops the installation without further changing the
installation les. You can continue the installation later
from this point.

Reset Resets all installation input les. All les in the
installation directory are removed from the system. No
backup is available.
You must restart the installation from the beginning.

Continue Continues with the option you have chosen before.

2.1.5.3 Interrupted Installation with SAPinst

The SAP system installation might be interrupted for one of the following reasons:

■ An error occurred during the processing phase:
SAPinst does not abort the installation in error situations. If an error occurs during the processing phase, the
installation will hold and a dialog box appears. The dialog box contains a short description about the choices
listed in the following table as well as a path to a log le that contains detailed information about the error.

■ You interrupted the installation by choosing Cancel.

The following table describes the options in the dialog box:
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Option Meaning

View Log SAPinst displays history information (log les) about the most recent steps
that you performed. These log les contain a short description of the error
that has occurred.
The dialog box remains in the background so you can choose Retry or Stop
after viewing the log information.

Retry SAPinst retries the installation from the point of failure without repeating
any of the previous steps.
This is possible because SAPinst records the installation progress in the
keydb.xml le.
We recommend that you view the entries in the log les, try to solve the
problem and then choose Retry.
If the same or a different error occurs again, SAPinst displays the same
dialog box again.

Stop SAPinst stops the installation, closing both the dialog box and the SAPinst
GUI.
SAPinst records the installation progress in the keydb.xml le. Therefore,
you can continue the installation from the point of failure without
repeating any of the previous steps. See the procedure below.

Reset SAPinst resets the installation so that you can now restart the installation
from the beginning, that is, with the default keydb.xml le.

. Caution
You must delete the previous installation before you restart SAPinst.
For more information, see Deletion of an SAP System Installation [page 40].

Continue SAPinst continues the installation from the current step.

Procedure
The following procedures describe the steps to restart an installation, which you stopped by choosing Stop, or to
continue an interrupted installation after an error situation.

1. Log on to your remote host as a user who is a member of the local administration group.
2. Insert the Installation Master DVD in your DVD drive.
3. Enter the following commands at the Windows command prompt:

cd <DVD drive>:\IM<x>_<OS>\SAPINST\NT\<platform>

sapinst.exe

4. From the tree structure in theWelcome screen, select the installation task that you want to continue and
choose Next.

. Note
If there is only one component to install, theWelcome screen does not appear.
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TheWhat do you want to do? screen appears.
5. In theWhat do you want to do? screen, decide between the following alternatives and conrm with OK.

Alternative Behavior

Run a new Installation The interrupted installation is not continued. Instead, SAPinst moves
the content of the old installation directory and all installation-specic
les to the backup directory. Afterwards, you can no longer continue
the old installation.
For the backup directory, the following naming convention is used:
<log_day_month_year_hours_minutes_seconds> (for example,
log_01_Oct_2003_13_47_56).

Continue old installation The installation that was interrupted is continued from the point of
failure.

2.1.5.4 Remote Installation with SAPInst (Optional)

2.1.5.4.1 General Information about the Remote
Installation with SAPinst (Optional)

You can run the SAPinst GUI in standalone mode to perform a remote installation.
This enables you to install an SAP system on another host (the remote host) while monitoring the installation
with the SAPinst GUI on your local Windows or UNIX computer (the local host).

Prerequisites

■ Both computers are in the same network and can ping each other.
To test this:
■ Log on to your remote host and enter the command ping <local host>.
■ Log on to the local host and enter the command ping <remote host>.

Process Flow

1. You start SAPinst on the remote host [page 26]
2. You start SAPinst GUI on the local host [page 27]
3. You perform the installation using the SAPinst GUI.
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2.1.5.4.2 Starting SAPinst on the Remote Host
(Optional)

You use this procedure to run SAPinst on the remote host when you want to run SAPinst as a remote
installation. The remote host is the host where you want to install the SAP system.

Prerequisites
You have prepared your system for SAPinst. For more information , see “Preparing the System for SAPinst”
in Part I ‒ Planning and Preparation.

Procedure

Your Remote Host Runs on a Windows Platform

1. Log on to your remote host as a user who is a member of the local administration group.
2. Insert the SAP Installation Master DVD in your DVD drive.
3. Enter the following commands from the Windows command prompt:

cd <DVD drive>:\IM<x>_<OS>\SAPINST\NT\<platform>

sapinst.exe SAPINST_START_GUI=false

For more information, also see Running SAPinst on Windows [page 18].
SAPinst now starts and waits for the connection to the SAPinst GUI. That is, you see the following at
the command prompt:
guiengine: no GUI connected; waiting for a connection on host <host_name>, port

<port_number> to continue with the installation

4. Start SAPinst GUI on your local host, as described in Starting SAPinst GUI on the Local Host [page 27].

Your Remote Host Runs on a UNIX Platform

1. Log on to your remote host as user root.
2. Mount the Installation Master DVD.
3. Enter the following commands:

cd <SAP_Installation_Master_DVD>/IM<x>_<OS>/SAPINST/UNIX/<OS>

./sapinst SAPINST_START_GUI=false

For more information, also see section Running SAPinst on UNIX in the Component Installation Guide
for UNIX.
SAPinst now starts and waits for the connection to the SAPinst GUI. That is, you see the following at
the command prompt:
guiengine: no GUI connected; waiting for a connection on host <host_name>, port

<port_number> to continue with the installation.

4. Start the SAPinst GUI on your local host, as described in Starting SAPinst GUI on the Local Host [page 27].
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2.1.5.4.3 Starting SAPinst GUI on the Local Host
(Optional)

You use this procedure to run SAPinst GUI on the local host when you want to run SAPinst as a remote
installation. The local host is the host where you want to control the installation with the SAPinst GUI.

Prerequisites
You have prepared your system for SAPinst. For more information, see “Preparing the System for SAPinst”
in Part I ‒ Planning and Preparation.

Procedure

Your Local Host Runs on a Windows Platform

1. Log on as a member of the local administration group.
2. Insert the SAP Installation Master DVD into your DVD drive.
3. Go to the following directory:

cd <DVD drive>:\IM<x>_<OS>\SAPinst\NT\<OS>

4. Start the SAPinst GUI in one of the following ways:
■ With additional parameters

Enter the following from the Windows command line:
startinstgui.bat -host <host_name> -port <port_number>

<host_name> is the host name of the installation host
<port_number> is the same port as SAPinst uses on the remote host

■ Without additional parameters
a) Enter the following from the Windows command line:

startinstgui.bat

The SAPinst GUI starts and tries to connect to SAPinst on the local host. However, normally there is
no SAPinst running on the local host.
Therefore, the SAPinst GUI cannot connect and the SAP Installation GUI Connection dialog appears.

b) Enter the host name of the Installation Host and the same Port as SAPinst uses on the remote host
and choose Log on.
SAPinst GUI connects to the SAPinst server and the rst dialog of the installation appears.

5. Perform the installation from your local host.

Your Local Host Runs on a UNIX Platform

1. Log on as user root.
2. Mount your installation DVD.

. Note
Mount the DVD locally. We do not recommend using Network File System (NFS).

3. Change to the following directory:
cd <SAP_Installation_Master_DVD>/IM<x>_<OS>/SAPINST/UNIX/<OS>
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4. Start the SAPinst GUI in one of the following ways:
■ With additional parameters

Enter the following from the UNIX command line:
./startinstgui.sh -host <host_name> -port <port_number>

<host_name> is the host name of the installation host
<port_number> is the same port as SAPinst uses on the remote host

■ Without additional parameters
a) Enter the following from the UNIX command line:

./startinstgui.sh

The SAPinst GUI starts and tries to connect to SAPinst on the local host. However, normally there is
no SAPinst running on the local host.
Therefore, the SAPinst GUI cannot connect and the SAP Installation GUI Connection dialog appears.

b) Enter the host name of the Installation Host and the same Port as SAPinst uses on the remote host
and choose Log on.
SAPinst GUI connects to the SAPinst server and the rst dialog of the installation appears.

5. Perform the installation from your local host.

2.2 Post-Installation Activities

This section provides information on how to perform the post-installation activities of your SAP system.
You are now here:
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Figure 3:

. Caution
You have completed the:

■ Planning and preparation activities, described in Part I of the Component Installation Guide
■ Installation activities, before you perform the post-installation activities.

You perform the following post-installation steps:

1. You start and stop the SAP system [page 30].
2. You log on to the J2EE Engine [page 31].
3. You install the SAP license [page 32].
4. You install the SAP online documentation [page 32].
5. If required, you apply the latest kernel and Support Packages [page 34].
6. You check the SAP Java documentation [page 33].
7. You perform a full installation backup [page 35] .
8. You change passwords of created users [page 36].
9. You apply strong encryption after the installation [page 37].
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2.2.1 Starting and Stopping the SAP System

You use this procedure to check that you can start and stop the SAP system after the installation. You use the
Microsoft Management Console (MMC) to start and stop the SAP system.

. Note
The newly installed MMC only allows you to start or stop the SAP system locally on the host that you are
logged on to. Later you can congure the MMC to enable central management of all hosts.
For more information, choose the following in the SAP Library: Solution Life Cycle Management → Solution
Monitoring → Monitoring in the CCMS → Microsoft Management Console: Windows.

Prerequisites

■ You have logged on to the SAP system host as user <sapsid>adm
■ You have checked the settings for VM parameters as described in SAP Note 723909.

Procedure

Starting the SAP System

1. To start the central services instance, central instance, and database instance:
a) On the SAP system host, choose Start → Programs → SAP Management Console.
b) Right-click the SAP system node and choose Start.

The central services, central instance, and database start.
2. If you have installed a dialog instance on another host, repeat the above steps on the dialog instance host.

. Note
Make sure that the SAP system (and its J2EE Engines) is up and running before you start or restart
dialog instances (and their J2EE Engines).

Stopping the SAP System

If you have installed a dialog instance on a dialog instance host, you rst have to stop the dialog instance before
you stop the central services instances, central instance, and database instance.

1. To stop the dialog instance:
a) On the dialog instance host, chooseStart → Programs → SAP Management Console.
b) Right-click the SAP system node and choose Stop.

2. To stop the central services instance, central instance, and database instance:
a) On the SAP system host, choose Start → Programs → SAP Management Console.
b) Right-click the SAP system node and choose Stop.

The central services instance, central instance and database instance stop.
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2.2.2 Logging On to the J2EE Engine

There are two standard users for the J2EE Engine after the installation, an administrator user and a guest user.
You need to check that you can log on to the J2EE Engine using the administrator user. The actual user ID
depends on your installation option and data source for user management. For more information, see the
following tables:

Java Add-In Users

User User ID
Data Source: ABAP

Initial Password

Administrator J2EE_ADMIN Set during installation process

Guest J2EE_GUEST Set during installation process

Java Standalone Users

User User ID
Data Source:
DBMS

User ID
Data Source: External ABAP

Initial Password

Administrator Administrator Set during the
installation process

Set during the
installation process

Guest Guest Set during the
installation process

Set during the
installation process

Prerequisites
You have already started the SAP system, including the J2EE Engine.

. Caution
During the installation, SAPinst prompts you to assign passwords for the administrator and other standard
users.

Procedure

1. Start a web browser and enter the following URL:
http://<hostname_of_SAP_J2EE_Engine_Server>:5<Instance_Number>00

. Example
If you installed the J2EE Engine on host saphost06 and the instance number of your J2EE Engine is
15, enter the following URL:
http://saphost06:51500

The start page of the J2EE Engine appears in the Web browser.
2. Log on by pressing EXAMPLES in the upper right corner of the Web page.
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2.2.3 Installing the SAP License

You must install a permanent SAP license. When you install your SAP system, a temporary license is
automatically installed. This temporary license allows you to use the system for only four weeks from
the date of installation.

. Caution
Before the temporary license expires, you must apply for a permanent license key from SAP.
We recommend that you apply for a permanent license key as soon as possible after having installed
your system.

. Note
If you installed a Java system as a prerequisite for the SAP Enterprise Portal installation, do not install the
SAP license now. The license of the SAP Web AS Java system is automatically installed as part of the SAP
Enterprise Portal installation. For more information, see Solution Life Cycle Management → SAP Licenses → SAP
License Keys → SAP License → Licensing the Portal in the SAP Library [page 6].

When you install the SAP Web AS license, a license for the J2EE Engine is installed automatically.

Procedure
The installation procedure of the SAP license depends on the installation that you performed:

■ If you installed an SAP Web AS ABAP+Java system or an SAP system based on SAP Web AS ABAP+Java, see:
■ Solution Life Cycle Management → SAP Licenses → SAP License Keys → SAP License in the SAP Library [page 6].
■ SAP Note 94998 (general)
■ SAP Note 767123 (especially for the licensing of SAP NetWeaver '04)

■ If you installed an SAP Web AS Java system, see Solution Life Cycle Management → SAP Licenses → SAP License Keys
→ Licensing of the SAP J2EE Engine in the SAP Library [page 6].

. Note
You can install multiple licenses, one for each host running a message server.
For example, on Windows, this applies if you have an installation with Microsoft Cluster Service (MSCS).
The SAP system then searches for the current license.

2.2.4 Installing the SAP Online Documentation

SAP currently provides an HTML-based solution for the online documentation, the SAP Library. The library
includes the Application Help, Glossary, Implementation Guide (IMG), and Release Notes. You can display the
documentation with a Java-compatible Web browser on all front-end platforms supported by SAP.

Procedure

Install the SAP online documentation (SAP Library) in your SAP system as described in the README.TXT le
contained in the root directory of the online documentation DVD, delivered as part of the installation package.
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For other ways to access the SAP Library, see Accessing the SAP Library [page 6].

2.2.5 Checking the SAP Java Documentation

You need to check important information about the conguration of the J2EE Engine and about SAP Java
technology in the SAP Library.

Procedure

1. In the SAP Library [page 6], choose SAP NetWeaver Conguration → SAP Web Application Server (Java) → J2EE Engine
Conguration → Template Conguration Tool.
Check the information here on the Template Conguration Tool, which enables you to congure the J2EE
Engine and the SAP NetWeaver components running on it.

. Note
The Template Conguration Tool will be available as of NW ’04 SP Stack 10.

2. In the SAP Library [page 6], choose Application Platforms (SAP Web Application Server) → Java Technology in SAP Web
Application Server.

3. Check the following:

Manual Contents

Architecture This manual describes the architecture of a Java or ABAP+Java system.
It contains information on:
■ Java cluster architecture including central services, load balancing,

and high availability.
■ J2EE Engine system architecture
■ SAP NetWeaver Java development infrastructure, including SAP

NetWeaver Developer Studio

. Note
The SAP NetWeaver Developer Studio is the SAP development
infrastructure for Java. The Architecture Manual describes the
integration of the SAP NetWeaver Developer Studio into the
SAP development infrastructure.
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Manual Contents

Administration This manual describes how to administer the SAP system, focusing on
the J2EE Engine. It contains information on:
■ Network and cluster infrastructure
■ Installation information
■ Server administration including J2EE Engine security
■ Administration of SAP NetWeaver Java development infrastructure

. Caution
Make sure that you check the mandatory post-installation
procedures listed in the Administration Manual under Installation
Information → Post-Installation Procedures.

Development This manual describes the technologies for developing Java-based
business applications. It explains how to use the SAP Netweaver
Developer Studio, which is the SAP Java development environment.

Migration This manual contains all the information you need to migrate an
application created in J2EE Engine 6.20.

Reference This manual contains reference information for administration and
development.

2.2.6 Applying the Latest Kernel and Support
Packages

You use this procedure to apply the latest kernel and Support Packages for your SAP system from SAP Service
Marketplace.

Procedure

1. Apply the latest kernel.
You must always replace the installed kernel with the latest kernel from SAP Service Marketplace. In
particular, you must replace the installed kernel in the following cases:
■ If you installed the kernel executables locally on every host
■ If your central instance host runs on a different operating system than your dialog instance host or

your gateway instance host
For more information about how to download a kernel, see SAP Note 19466.

2. Apply Support Packages.
You have to apply SAP NetWeaver ‘04 support package stacks as described in the documentation Support
Package Stack Guide ‒ SAP Netweaver ’04 Support Package Stack <current stack> on SAP Service Marketplace at:
service.sap.com/instguidesNW04 → Operations → Cross-NW:
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2.2.7 Performing a Full Installation Backup

You must perform an ofine full backup at the end of the installation.

Prerequisites

■ You have completed client maintenance (for example, client copy).
■ You have stopped:

■ The SAP system
■ SAP-related services (SAP<SAPSID>_<instance> and SAPOSCol)
■ The database

■ You are logged on as user <sapsid>adm.
■ You have shut down the SAP system and database.

Procedure

1. Save the registry:
a) Choose Start → Programs → Accessories → System Tools → Backup.
b) Choose Emergency Repair Disk.

The Emergency Repair Diskette dialog box appears.
c) Select Also Backup the Registry to the Repair directory…

When you conrm your entry, the registry is written to diskette.
2. Save the system state data:

a) Choose Start → Programs → Accessories → System Tools → Backup.
b) Choose Backup Wizard → Next.
c) Select Only back up the System State data and choose Next.
d) InWhere to Store the Backup, select the Backup media type and enter the Backup media or le name.
e) Choose Next.
f) Check the information displayed and choose Finish to start the backup.

3. Back up all SAP-specic and all database-related directories:
a) Choose Start → Programs → Accessories → System Tools → Backup.
b) Choose Backup Wizard → Next.
c) Select Back up selected les, drives, or network data and choose Next.
d) InWhat to back up, select the Windows directory and all SAP and database-related directories, including:

\USR\SAP

<HOMEDIR> of <sapsid>adm

\%WINDIR%

e) Choose Next.
f) InWhere to Store the Backup, select the Backup media type and enter the Backup media or le name for the backup.
g) Choose Next.
h) Check the information displayed and then choose Finish to start the backup.
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2.2.8 Changing Passwords of Created Java Users

You need to change the password of the user(s) that SAPinst creates during the installation, as shown in the
table below.
For security reasons, you also need to copy the installation directory to a separate, secure location. For
example, you can copy it to a removable storage medium such as a DVD, which you then store separately and
securely. Finally, delete the installation directory from your SAP system.

Procedure

. Caution
Make sure that you perform this procedure before the newly installed SAP system goes into production.

Change the password of this user according to the SAP Security Guide.
For more information, see SAP Service Marketplace at service.sap.com/securityguide.

. Note

■ SAP system users might exist in more SAP system clients than listed below (for example, if a user was
copied as part of the client copy. For more information, see “Performing the Client Copy” in Part II —
Installation and Post-Installation of the ABAP installation guide.

■ We strongly recommend that you change the initial passwords even if SAPinst prompted for a new
password during the installation procedure.

User Type User Comment

SAP system user SAPJSF User exists at least in SAP system
client that you have specied
during the installation.

. Recommendation
You do not need to change the initial passwords of SAP system users. However, we recommend you to
take the precautions described in the table below:

User Type User Precaution

J2EE Engine Administrator Administrator or J2EE_ADMIN This user’s password is stored
in secure storage. Therefore,
whenever you change the
administrator’s password, you
must also re-encrypt the password
in secure storage.
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User Type User Precaution

Guest account on the J2EE Engine Guest or J2EE_GUEST Lock this user to prevent it from
being used for explicit logons.

Communication user for the J2EE
Engine

SAPJSF This user is only necessary if you
use an ABAP system as the data
source for user management. For
more information, see “Preparing
User Management for an External
ABAP System” in Part I — Planning
and Preparation.
Specify this user as a Communications
user and not as a dialog user.
This user exists at least in the SAP
system client that you specied
during the installation.

2.2.9 Applying Strong Encryption After the
Installation

If you installed the J2EE Engine with weak encryption but want to change to strong encryption later, then
you can deploy the library after the installation. For more information see SAP Library [page 6]→ Application
Platform (SAP Web Application Server) → Java Technology in SAP Web Application Server → Administration Manual →
Installation Information → Post-Installation Procedures.

2.3 Additional Information

This section provides additional information about the installation of your SAP system.

1. Additional Information about the J2EE Engine [page 37]
2. Conguring User Management to User an LDAP Directory [page 40].
3. Deleting an SAP System [page 40]

2.3.1 Additional Information about the J2EE Engine

. Note
For more information, also see “Java Technology in SAPWeb Application Server” in the SAP library [page 6].
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File System Structure of the J2EE Engine Installation

After the installation of the J2EE Engine, the following le system structure applies for the J2EE Engine (j2ee)
and its Software Deployment Manager (SDM):

Figure 4:

For more information on SDM, see “The Software Deployment Manager” below in this section.

. Example
For example, the le system structure might look as follows:
On a dialog instance with instance name D01 on Windows, the J2EE Engine is installed to
c:\usr\sap\C11\D01\j2ee. No SDM is installed.

. Note
SAP Web AS Java system only:
The instance name (instance ID) of the central instance is JC<Instance_Number>, the instance name
of a Java dialog instance is J<Instance_Number>.
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Procedure

Starting the Administration Tool of the J2EE Engine

. Note
For more information about the administration tool of the J2EE Engine, see Java Technology in SAP Web
Application Server → Administration Manual → Server Administration → J2EE Engine Administration Tools → Visual
Administrator in the SAP Library [page 6].

1. For the user who will run the administration tool (for example, <sapsid>adm), make sure that the
SAPINST_JRE_HOME environment variable contains the path to the Java Development Kit (JDK) of the
J2EE Engine.

2. Enter the following command to start the administration tool:
/usr/sap/<SAPSID>/<Instance_Name>/j2ee/admin/go

<Drive>:\usr\sap\<SAPSID>\<Instance_Name>\j2ee\admin\go.bat

3. The J2EE Engine ‒ Administration screen with the dialog box Connect to J2EE Engine appears.
4. To connect do the following:

Installation Option How to Connect

Java System Choose Connect to use the Default login and enter the password for the
Administrator user of the J2EE Engine.

Java Add-In You cannot use the Default login. Instead, perform the following steps:
a) Choose New.
b) Enter a display name and choose Direct Connection to a dispatcher Node.
c) Choose Next.
d) Enter at least the following:

■ User Name: J2EE_ADMIN
■ Host: <host_name> of the J2EE engine
■ Port: <P4_Port>

The following convention applies for the port:
5<Instance_Number_of_SAP_J2EE_Engine>04. For example, if
your J2EE instance number is 15, the P4port is 51504.

e) Choose Save and connect with your new login account by choosing
Connect.

f) Enter the password for the J2EE_ADMIN user and choose Connect.

Deactivation of the J2EE Engine

. Note
This section is only valid for the Java Add-in.

After the installation, the J2EE Engine is activated. If you do not want to use the J2EE Engine, you can deactivate
it by setting the parameter rdisp/j2ee_start to 0 in the instance prole of every installed SAP instance:
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<DRIVE>:\usr\sap\<SAPSID>\sys\profile\<SAPSID_INSTANCENAME_HOSTNAME>

Software Deployment Manager

Every J2EE Engine on a central instance and every J2EE Engine installed standalone requires a Software
Deployment Manager (SDM). SDM is a tool for managing and deploying SAP software packages.
For more information, seeApplication Platform → Java Technology in SAP Web Application Server → Development Manual →
Deployment: Putting it all together → Software Deployment Manager in the SAP Library [page 6].

2.3.2 Conguring User Management to Use an LDAP
Directory (Optional)

If your user data source is an LDAP directory, you need to congure the connection to the LDAP directory
after installation.
For more information, see “Conguring UME to Use an LDAP Server as Data Source” in SAP Library [page 6]→
Security → Identity Management → User Management Engine → UME Conguration → Conguring UME to Use an LDAP
Server as Data Source

2.3.3 General Information on How to Delete an SAP
System

Purpose

The following sections describe how to delete a particular component or a complete SAP system.

. Note
The description assumes that the installation of your SAP system has been performed with SAP standard
tools according to the installation documentation.

Process Flow

. Caution
If you delete network-wide users, groups or service entries in an environment with Network Information
System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service
entries to be deleted are no longer required.

Deleting a Complete SAP System

1. You delete all dialog instances [page 41], if there are any.
2. You delete the central services instance [page 41].
3. You delete the central instance [page 41].
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. Note
When you delete the central instance, the Java Add-In installation is deleted automatically together
with the central instance.

4. You delete the MS SQL Server database instance and the database software [page 44]

. Note
When you delete the database instance, the Java database schema is deleted automatically together with
the database instance.

Deleting the Java Add-In Installation

The following describes how to delete the Java part of ABAP+Java system. With this procedure you do not
delete the ABAP system.

1. You delete the Java parts of all dialog instances, [page 41] if there are any.
2. You delete the Java Add-In installation [page 42].
3. You delete the central services instance [page 41].
4. You delete the Java database schema [page 44]

2.3.4 Deleting an SAP Instance

You use this procedure to delete a particular SAP instance.

. Note

■ With this procedure you do not delete the Java Add-In installation, or the database instance.
■ When you delete a SAP system installation, you need to uninstall the SAP instance software.

Prerequisites
The SAP instance is stopped.

Procedure

. Caution
We recommend that you use this procedure only if you have performed a full backup of your SAP instance.

1. Log on as a user with domain administration rights.
2. Choose Start → Settings → Control Panel → Add/Remove Programs.
3. The Add/Remove Programs dialog box appears.
4. Find the SAP entries.
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. Note
Each SAP instance that is installed on the computer is listed with an entry like SAP Application Server
for System <SAPSID> instance.

5. Choose Remove.
The SAP Uninstall Wizard starts.

6. In theWelcome window, choose Next.
The dialog box Uninstalling SAP System appears for you to select an uninstall method.

. Caution
Depending on your selection, note the following when you use the check box to delete an SAP instance:
■ If your check box is marked gray, you delete or uninstall the following:

■ The SAP instance directory, for example:
\usr\sap\<SAPSID>\D00

■ Services, for example:
SAP<SAPSID>_00

■ The whole system directory, for example:
\usr\sap\<SAPSID>\*

■ If your check box is marked black, you delete or uninstall the following:
■ The SAP instance directory, for example:

\usr\sap\<SAPSID>\D00

■ Services, for example, SAP <SAPSID>_00

■ The whole system directory, for example:
\usr\sap\<SAPSID>\*

■ Local and domain user accounts
■ If you have different SAP instances that use the same <SAPSID>, you can delete the instance

directory only.
The wizard informs you when the SAP system or selected instances have been deleted successfully.

2.3.5 Deleting a Java Add-In Installation

This section describes how to delete the Java Add-In installation of your SAP system.

. Note
If you delete a Java Add-In installation, the ABAP system is not deleted.

. Caution
This description assumes that the installation of your SAP system has been performed using SAP standard
tools according to the installation documentation.

Procedure

1. Stop the central services instance and all dialog instances of your SAP system:
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a) Log on to the corresponding instance host as user <sapsid>adm.
b) Execute the following commands:

■ To stop the central services instance:
stopsap <SCSinstanceName>

■ To stop a dialog instance:
stopsap <DialogInstanceName>

2. Stop the J2EE Engine of the central instance:
a) Log on to your SAP system.
b) Call transaction SMICM.
c) Choose Administration → J2EE Server → send hard shutdown.

. Note
You do not need to stop the central instance.

3. If lines beginning with the following parameters appear, delete these lines from the default prole,
\usr\sap\<SAPSID>\SYS\profile\default.pfl:
j2ee\dbname =

j2ee\dbtype =

j2ee\dbhost =

j2ee\dbadminurl =
4. If lines beginning with the following parameters appear, delete these lines

from the central instance prole and from all dialog instance proles,
\usr\sap\<SAPSID>\SYS\profile\<SAPSID>_<INSTANCE_NAME>_<host_name>:
exe\j2ee =

rdisp\j2ee_start_control =

rdisp\j2ee_start =

rdisp\j2ee_timeout =

rdisp\frfc_fallback =

jstartup\trimming_properties =

jstartup\instance_properties =

jstartup\protocol =

exe\jlaunch =

5. Delete the central services instance [page 41].
6. Delete the Java database schema [page 44].
7. Delete the following directories (<xx> is the central instance number):
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■ \usr\sap\<SAPSID>\DVEBMGS<xx>\SDM

■ \usr\sap\<SAPSID>\DVEBMGS<xx>\j2ee

2.3.6 Deleting the MS SQL Server Database Instance
and the Database Software

This section describes how to delete the MS SQL Server database instance, the database schema, or the
database software.

Prerequisites
Before deleting the database schema, or database instance, make sure that you have:

■ Performed a recent ofine database backup.

. Note
This step is mandatory if you have more than one schema in the same database.

■ Stopped or deleted all SAP instances belonging to this database schema.

Procedure

Deleting the MS SQL Server Database Instance, or the Database Schema

1. Log on as local administrator.
2. Delete the MS SQL Server database instance using one of the following ways:

■ Use the Database Tools from your SAPinst Installation Master DVD.
a) Start SAPinst and choose Database Tools→ MS SQL Server → Delete Database Schema.
b) Follow the dialogs.

For more information about how to use SAP Tools for MS SQL Server, see SAP Note 683447.
■ Delete the database schema manually as described in SAP Note 639710.

Deleting the MS SQL Server Database Software

Use the MS SQL Server Uninstaller under Add or Remove Programs.
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A Reference

A.1 The Main SAP Documentation Types

The following is an overview of themost important documentation types that you need in the various
phases in the life cycle of an SAP solution.

Figure a: Documentation types in the software life cycle

Cross-Phase Documentation

SAPterm—SAPterm is SAP’s terminology database. It contains SAP-specic vocabulary in over 30 languages,
as well as many glossary entries in English and German.

■ Target group:
■ Relevant for all target groups
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■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/sapterm

SAP Library—The SAP Library is a collection of function- and process-oriented documentation for SAP
components. The SAP Library also contains the Business Scenario Descriptions.

■ Target group:
■ Consultants
■ System administrators
■ Project teams for implementations or upgrades

■ Current version:
■ Located in the SAP Help Portal at help.sap.com (also available as documentation CD)
■ Located in the SAP Service Marketplace at service.sap.com/ibc (only the Business Scenario

Descriptions)

Implementation Guide (IMG)—The Implementation Guide is a tool for conguring the SAP system to meet
customer requirements. Its structure and documentation are component-oriented.

■ Target group:
■ Solution consultants
■ Project teams for implementations or upgrades

■ Current version:
■ In the SAP menu of the SAP system under Tools → Customizing → IMG

Security Guide—The Security Guide describes the settings for a medium security level and offers suggestions
for raising security levels. A collective security guide is available for the SAP NetWeaver technologies, such as
the SAP Web Application Server (SAP Web AS). This document contains general guidelines and suggestions
about system security. Other technologies and individual applications have a Security Guide of their own.

■ Target group:
■ Technology consultants
■ Solution consultants
■ Project teams for implementations or upgrades

■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/securityguide

Implementation

Master Guide—The Master Guide is the starting point for implementing an SAP solution. It lists the required
SAP components, and third-party applications that are required for each Business Scenario. It provides
scenario-specic descriptions of preparation, execution, and follow-up of an implementation. It also offers
references to other documents, such as Component Installation Guides and SAP Notes.

■ Target group:
■ Technology consultants
■ System administrators
■ Project teams for implementations

■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/instguides
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Component Installation Guide—The Component Installation Guide describes the technical
implementation of an SAP component, taking into account the combinations of operating systems and
databases. It does not describe any business-related conguration.

■ Target group:
■ Technology consultants
■ Project teams for implementations

■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/instguides

Conguration Documentation in SAP Solution Manager—SAP Solution Manager is a tool with various
functions, one of its main functions being the conguration of SAP solutions and Business Scenarios. It
contains IMG activities, transactions, and so on, as well as documentation. Instead of the conguration
documentation in SAP Solution Manager, there may be separate Business Scenario Conguration Guides in
the SAP Service Marketplace for previous shipments of the Business Scenarios.

■ Target group:
■ Solution consultants
■ Project teams for implementations

■ Current version:
■ In SAP Solution Manager
■ Located in the SAP Service Marketplace at service.sap.com/ibc

Production Operation

Solution Management Guide—The Solution Management Guide is the starting point for operating an SAP
solution. The guide refers users to the tools and documentation that are needed to carry out various tasks,
such as monitoring, backup / restore, master data maintenance, transports, and tests. It also refers users to
other documents, for example the SAP Library, the Master Guide, and the Component Management Guides.

■ Target group:
■ System administrators
■ Technology consultants
■ Solution consultants
■ Project teams for implementations or upgrades

■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/instguides

Upgrade

Upgrade Master Guide—The Upgrade Master Guide is the starting point for upgrading the Business
Scenarios of an SAP solution. It provides scenario-specic descriptions of preparation, execution, and follow-up
of an upgrade. It also refers to other documents, such as the Component Upgrade Guides and SAP Notes.
Instead of an Upgrade Master Guide, there may be several Business Scenario Upgrade Guides or a Solution
Upgrade Guide for previous shipments of the Business Scenarios of an SAP solution.

■ Target group:
■ Technology consultants
■ Project teams for upgrades

■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/instguides
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Component Upgrade Guide—The Component Upgrade Guide describes the technical upgrade of an SAP
component, taking into account the combinations of operating systems and databases. It does not describe any
business-related conguration.

■ Target group:
■ Technology consultants
■ Project teams for upgrades

■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/instguides

Release Notes—Release Notes are documents that contain short descriptions of new features or changes
in an SAP component since the previous release. Release Notes about ABAP developments enable the SAP
system to generate delta and upgrade IMGs

■ Target group:
■ Consultants
■ Project teams for upgrades

■ Current version:
■ Located in the SAP Service Marketplace at service.sap.com/releasenotes
■ In the SAP menu of the SAP system under Help → Release Notes (only ABAP developments)
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